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SUMMARY

Quantitative analysis using a turn-on fluorescent probe is inherently difficult due
to the dependency of the fluorescence intensity on the probe concentration. To
overcome this limitation, we developed an in situ quantification method using a
turn-on fluorescent probe and a standard fluorophore, which are colocalized by
protein tag technology. This protocol describes the synthesis of a Zn2+ probe,
named ZnDA-1H, and the procedure to quantify the labile Zn2+ concentration
in the Golgi of live HeLa cells by confocal fluorescence microscopy.
For complete details on the use and execution of this protocol, please refer to
Kowada et al. (2020).

BEFORE YOU BEGIN

Small-molecule fluorescent Zn2+ probes have rarely been used for the quantitative analysis of sub-

cellular labile Zn2+ concentration despite the fine tunability of their optical properties, coordination

properties, and chemical stability. One of the main reasons is the lack of subcellular localization,

which often results in leakage from live cells during observation or undesired subcellular accumula-

tion. To address these problems, we developed an in situ standard quantification method, where a

turn-on green fluorescent probe and an internal standard red fluorescent dye are colocalized in a

target subcellular compartment using the HaloTag labeling technology (Figure 1). By using the ratio

calculated from these two probe signals, it is possible to eliminate signal fluctuations resulting from

cell morphological movements, focus deviations, local probe concentration changes, etc. The use of

this quantification method with our less pH-sensitive Zn2+ fluorescent probe, ZnDA-1H, instead of

more pH-sensitive protein-based probes could allow a more stable quantification of labile Zn2+ in

the Golgi apparatus.

Note: Unless otherwise specified, all reagents were purchased from chemical suppliers and

used without further purification.

Assembly of reaction apparatus for moisture-sensitive reactions

Timing: 30 min

This section outlines how to assemble a reaction apparatus for organic synthesis, which is necessary

to carry out the reaction in a water-free and inert atmosphere.
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1. Assemble a reaction apparatus consisting of a two-neck round-bottom flask, a stirring bar, a rub-

ber septum, a balloon for N2 gas, a three-way stopcock, and a Dimroth condenser (for heating

reactions).

2. Dry the apparatus using a heating gun in vacuo.

3. After cooling down to ambient temperature (20–25�C), fill the balloon and apparatus with N2 gas.

Preparation of media for HeLa cell culture

Timing: 5 h

This section outlines the preparation of minimum essential medium (MEM) for HeLa cell culture.

4. Autoclave two 250-mL glass bottles with a cap.

5. After cooling down, mix MEM and FBS (f. c. 10%) on a clean bench.

a. For subculture, mix 120 mL of MEM, 13.5 mL of FBS, and 1.35 mL of penicillin-streptomycin

solution (P/S, f. c. 1%).

b. For transfection, mix 121.5 mL of MEM and 13.5 mL of FBS.

6. Store the media at 4�C.

CRITICAL: Avoid the use of antibiotics during transfection. Antibiotics can reduce trans-

fection efficiency or cause cell death.

Preparation of Ca2+/Mg2+-free phosphate-buffered saline (PBS)

Timing: 4 h

This section outlines the preparation of PBS solution from powder.

7. Dissolve 1.44 g of D-PBS powder that does not contain Ca2+ or Mg2+ in 150 mL of Milli-Q water

contained in a 250-mL glass bottle.

8. Autoclave the glass bottle with a cap.

Figure 1. Schematic illustration of in situ standard quantification method

Reprinted with permission from Kowada et al., 2020.
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9. After cooling down, store it at 4�C.

Preparation of Chelexed HHBSS buffer for quantifying Zn2+ concentration in live cells

Timing: 10 h

This section outlines the preparation of HEPES-buffered HBSS (HHBSS; phosphate, calcium, and

magnesium-free) for in situ Zn2+ calibration during live-cell imaging.

10. Mix 3.20 g of NaCl (f. c. 8.0 g/L), 0.160 g of KCl (f. c. 0.40 g/L), 12.0 mL of 1.0 M HEPES-NaOH

buffer (pH 7.4), and 345 mL of Milli-Q water in a 500-mL conical flask.

11. Pour the solution into an empty glass chromatography column with a porous polymer bed sup-

port (50 mm I.D. 3 200 mm, Econo-column chromatography column, Bio-Rad).

12. Add 3.60 g of Chelex. Mix by inverting 10 times and allow it to stand for 6 h at 4�C.
13. Discard the first 5 mL fraction and collect the following fraction in a 500-mL glass bottle.

14. Autoclave the bottle.

15. After cooling down, supplement the solution with 40.0 mL of filter-sterilized 30 g/L glucose (f. c.

3.0 g/L) on a clean bench.

16. Store at 4�C.

CRITICAL: The HBSS buffer, which normally contains phosphate ions, is used as an imaging

buffer. This often leads to precipitate formation after the addition of zinc pyrithione.

Preparation of a dish lid with a small hole and a solution injection tool

Timing: 30 min

This section outlines the preparation of a handmade dish lid and a solution injection tool to add re-

agents to cells during imaging.

17. Make a 5–9 mm diameter hole on the lid of a 35-mm glass-bottom dish using a cork borer (Fig-

ure 2).

18. Cut a silicone tube into three pieces of lengths 17, 37, and 45 cm.

19. Remove the Luer lock part of the 16-G blunt-tip stainless needle and prepared two tubes.

Slightly bend one end.

20. Combine them with a 5-mL plastic syringe and Luer fittings to assemble the tool (Figure 3).

KEY RESOURCES TABLE

REAGENT or RESOURCE SOURCE IDENTIFIER

Antibodies

anti-GM130 rabbit polyclonal antibody MBL Cat#PM061; RRID: AB_10598333

CF568-conjugated donkey-anti-rabbit
IgG

Biotium Cat#20098-1; RRID: AB_10853318

Chemicals, peptides, and recombinant proteins

Acetic acid (AcOH) FUJIFILM Wako Pure Chemicals Cat#017-00256

Acetonitrile (MeCN, dehydrated) FUJIFILM Wako Pure Chemicals Cat#018-22901

Acetonitrile (MeCN, HPLC grade) FUJIFILM Wako Pure Chemicals Cat#015-08633

2-(Bromomethyl)pyridine
hydrobromide

Sigma-Aldrich Cat#491047-5G

1-Butanol FUJIFILM Wako Pure Chemicals Cat#023-03336

tert-Butyl 4-bromobutyrate (Patel et al., 2004) N/A

Ca(OAc)2$H2O Nacalai Tesque Cat#06717-92

(Continued on next page)
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Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

CDCl3 Eurisotop Cat#D307HAG

CD2Cl2 FUJIFILM Wako Pure Chemicals Cat#049-34264

Celite 535RVS Nacalai Tesque Cat#08019-95

2-(2-((6-Chlorohexyl)oxy)ethoxy)ethan-
1-amine

(Singh et al., 2013) N/A

Citric acid FUJIFILM Wako Pure Chemicals Cat#030-05525

Dichloromethane (CH2Cl2) Nacalai Tesque Cat#22414-94

Dichloromethane (CH2Cl2,
dehydrated)

Kanto Chemical Cat#11338-84

N-(3-Dimethylaminopropyl)-N0-
ethylcarbodiimide hydrochloride
(EDC$HCl)

Peptide Institute Cat#1030

N,N-Dimethylformamide (DMF,
dehydrated)

Kanto Chemical Cat#11339-84

Dimethyl sulfoxide (DMSO) FUJIFILM Wako Pure Chemicals Cat#045-28335

DMEM Nacalai Tesque Cat#08490-05

D-PBS without Ca and Mg, powder Nacalai Tesque Cat#07269-84

Ethyl acetate (EtOAc) Nacalai Tesque Cat#14622-14

Ethyl nitroacetate TCI Cat#N0657

FBS Gibco Cat#10270-106

Formic acid (HCOOH, HPLC grade) FUJIFILM Wako Pure Chemicals Cat# 066-00461

FuGENE HD Promega Cat#E231A

D-(+)-Glucose Nacalai Tesque Cat#16806-25

200 mM-L-Glutamine Nacalai Tesque Cat#16948-04

H2 gas Tanuma Sanso N/A

Hank’s balanced salt solution (HBSS) Nacalai Tesque Cat#09735-75

HaloTag TMR ligand (HTL-TMR) Promega Cat#G825A

HEPES Dojindo Laboratories Cat#342-01375

Hexane Nacalai Tesque Cat#17922-94

1-Hydroxybenzotriazole monohydrate
(HOBt$H2O)

Peptide Institute Cat#1022

KCl FUJIFILM Wako Pure Chemicals Cat#163-03545

K2CO3 Nacalai Tesque Cat#28509-55

2-Mercaptopyridine N-oxide
(pyrithione)

TCI Cat#H0302

MEM Nacalai Tesque Cat#21442-25

Methanol (MeOH) Nacalai Tesque Cat#21915-64

MgSO4 Nacalai Tesque Cat#21032-95

N2 gas Tanuma Sanso N/A

NaCl FUJIFILM Wako Pure Chemicals Cat#191-01665

NaHCO3 FUJIFILM Wako Pure Chemicals Cat#195-01303

Na2SO4 Nacalai Tesque Cat#31916-15

Na2S2O3$5H2O Nacalai Tesque Cat#32005-15

NH2-modified silica gel thin-layer
chromatography (TLC) plate

Merck Cat#1.05533.0001

NH2-silica gel Fuji Silysia Chemical Cat#NH-DM1020

Opti-MEM Thermo Fisher Scientific Cat#31985062

Pd/C Sigma-Aldrich Cat#205699-1G

Piperidine FUJIFILM Wako Pure Chemicals Cat#160-02771

Penicillin-streptomycin mixed solution Nacalai Tesque Cat#26253-84

Phosphorus oxychloride (POCl3) Kanto Chemical Cat#32192-20

Silica gel Fuji Silysia Chemical Cat#BW-300

Silica gel TLC plate Merck Cat#1.05715.0001

1,2,3,4-Tetrahydroquinolin-7-ol (Anzalone et al., 2013) N/A

N,N,N0,N0-Tetrakis(2-
pyridylmethyl)ethylenediamine (TPEN)

Dojindo Laboratories Cat#340-05411

Tetramethylammonium bromide TCI Cat#T0135

(Continued on next page)

ll
OPEN ACCESS

4 STAR Protocols Volume, 100395, June 18, 2021

Protocol



MATERIALS AND EQUIPMENT

� Prepare a 10 mM TPEN stock solution by dissolving 12.7 mg (0.0300 mmol) of TPEN in 3.0 mL of

DMSO. TPEN is a membrane-permeable and high-affinity zinc chelator. Prepare aliquots of the

stock solution and store at �20�C.

Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

Triethylamine (Et3N, dried by
distillation over KOH)

FUJIFILM Wako Pure Chemicals Cat#202-02646

Trifluoroacetic acid (TFA) FUJIFILM Wako Pure Chemicals Cat#208-02741

Trypsin-EDTA solution Nacalai Tesque Cat#32777-44

0.5%-Trypan blue stain solution Nacalai Tesque Cat#29853-34

ZnSO4$7H2O FUJIFILM Wako Pure Chemicals Cat#269-01052

Compound 2 (Kowada et al., 2020) N/A

Compound 3 (Kowada et al., 2020) N/A

Compound 4 (Kowada et al., 2020) N/A

Compound 5 (Kowada et al., 2020) N/A

Compound 6 (Kowada et al., 2020) N/A

ZnDA-1H (Kowada et al., 2020) N/A

Experimental models: cell lines

HeLa RIKEN BRC Cat#RCB0007

Recombinant DNA

pEF4MycHisB-hManII-Halo (Kowada et al., 2020) N/A

Software and algorithms

Data Analysis 4.0 Bruker Daltonics N/A

FluoView Olympus N/A

ImageJ (Fiji) National Institutes of Health https://imagej.net/Fiji/Downloads

KaleidaGraph 4.5 Synergy Software N/A

Microsoft Excel 2016 Microsoft N/A

TopSpin 3.6.1 Bruker BioSpin https://www.bruker.com/service/
support-upgrades/software-
downloads/nmr.html

Other

Balloon AS ONE Cat#3-3318-11

Blunt-tip stainless needle (16G, 80mm) Sansyo Cat#72-0451

Chelex 100 Chelating Resin Bio-Rad Cat#1432832

Confocal laser scanning microscope
(FV1000)

Olympus N/A

60-mm culture dish AS ONE Cat#2-8590-02

Econo-column chromatography
column

Bio-Rad Cat#7375031

35-mm glass-bottom dish AGC Techno Glass Cat#3971-035

Hemocytometer Erma Cat#03-303-1

Inertsil ODS-3 column, for semi-prep GL Sciences Cat#5020-06812

Lens cleaner (HYPER CLEAN 6310) Olympus N/A

Luer fitting (female, VRF106) AS ONE Cat#5-1043-07

Luer fitting (male, VRM106) AS ONE Cat#5-1043-01

micrOTOF-Q II mass spectrometer Bruker Daltonics N/A

NMR spectrometer (AVANCE III 400) Bruker BioSpin N/A

NMR spectrometer (AVANCE III HD
500)

Bruker BioSpin N/A

Objective lens (UPLSAPO60XS2) Olympus N/A

5-mL plastic syringe Terumo Cat#SS-05SZ

Stage top incubator Tokai Hit Cat#INUBTF-WSKM

Silicone immersion oil Olympus Cat#SIL300CS-30CC

Silicone tube (I.D. 1 mm 3 O.D. 2 mm) AS ONE Cat#9-869-02

Syringe filter (0.2 mm, SFCA) Sartorius Cat#17597K
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� Prepare 10 and 20 mM ZnSO4 stock solutions by dissolving 8.63 mg (0.0300 mmol) or 17.3 mg

(0.0600 mmol) of ZnSO4$7H2O in 3.0 mL of Milli-Q water. Sterilize the solutions with a syringe fil-

ter, prepare aliquots of the solutions, and store them at �20�C.
� Prepare a 2.0 mM pyrithione stock solution by diluting a 20 mM pyrithione stock solution, which is

prepared by dissolving 2.5 mg (0.020 mmol) of pyrithione in 1.0 mL of DMSO. Prepare aliquots of

the solutions and store them at �20�C.
� Prepare a 180 mM Ca(OAc)2 stock solution by dissolving 31.7 mg (0.180 mmol) of Ca(OAc)2$H2O

in 1 mL of Milli-Q water. After sterilization with a syringe filter, store at �20�C.
� Determine the concentration of ZnDA-1H in CD2Cl2 by quantitative NMR spectroscopy. After dry-

ing, prepare a 10 mM ZnDA-1H stock solution by dissolving it in DMSO. Dilute the 10 mM solution

to 250 mM with DMSO. Prepare aliquots of the stock solution and store at �20�C.

CRITICAL: Avoid repeated freeze-thaw cycles, which may lead to the degradation of the

compound. Store the ZnDA-1H solution under dark conditions.

� Prepare a 5.0 mM HTL-TMR solution by diluting the 5 mM stock solution of HTL-TMR with DMSO.

Store the solution at �20�C.
� On the day of use, supplement DMEM with 4.0 mM glutamine (50-times dilution of 200 mM gluta-

mine) and chelexed HHBSS buffer with 1.8 mM Ca(OAc)2 (100-times dilution of the 180 mM stock

solution) and 1.0 mM ZnSO4 (1000-times dilution of the 10 mM stock solution). Prepare a working

solution of 25 mM ZnDA-1H (10-times dilution of the stock solution) and 0.50 mM HTL-TMR (10-

times dilution of the 5.0 mM stock solution) in DMEM containing 4.0 mM glutamine and 20%

DMSO. Prepare a 200 mM TPEN working solution in chelexed HHBSS buffer by diluting the

10 mM TPEN stock solution in DMSO.

CRITICAL: A low concentration of DMSOmay lead to the adsorption of ZnDA-1H and HTL-

TMR on a plastic tube, resulting in insufficient labeling of HaloTag. Store the working so-

lution of the probes at 4�C under dark conditions.

� Thirty min prior to the imaging, warm up the 200 mM TPEN working solution and chelexed HHBSS

buffer for the preparation of a zinc pyrithione (ZPT) working solution. Immediately prior to the image

acquisition, prepare the working solution of ZPT consisting of 4.4 mM ZnSO4 and 22 mM pyrithione

in chelexed HHBSS buffer by diluting the stock solutions of 20 mM ZnSO4 and 2.0 mM pyrithione.

Figure 2. A dish lid with a small hole

ll
OPEN ACCESS

6 STAR Protocols Volume, 100395, June 18, 2021

Protocol



CRITICAL: The ZPT working solution should be prepared just before imaging. The ZPT

complex may not be stable for longer incubation or storage.

STEP-BY-STEP METHOD DETAILS

Synthesis of tert-butyl 4-(7-hydroxy-3,4-dihydroquinolin-1(2H)-yl)butanoate (2)

Timing: 4 days

This method outlines the preparation of compound 2 (Figure S1).

1. Weigh 0.780 g (5.23 mmol) of 1,2,3,4-tetrahydroquinolin-7-ol (1) (Anzalone et al., 2013), 0.550 g

(6.55 mmol) of NaHCO3, and 82.0 mg (0.532 mmol) of tetramethylammonium bromide in a 50 mL

two-neck round-bottom flask containing a magnetic stirring bar.

2. Add 5.0 mL of H2O to the flask.

3. Slowly add 1.43 g (6.41 mmol) of tert-butyl 4-bromobutyrate (Patel et al., 2004) at 0�C to the

aforementioned flask.

4. Stir the suspension at room temperature (20–25�C) for 70 h.

5. Extract the reactionmixture with EtOAc (33 40mL) using a separatory funnel to obtain an organic

layer. Wash the organic layer with brine (23 40mL). Dry the organic layer withMgSO4 and filter to

remove the MgSO4. Remove the volatile material using a rotary evaporator under reduced pres-

sure to obtain a brown oil (2.25 g).

6. Purify the crude product using silica gel column chromatography (EtOAc/hexane = 8/92) to afford

compound 2 (0.512 g, 1.76 mmol, yield 34%, Rf = 0.4 (EtOAc/Hexane = 1/4)) as a pale yellow oil.

7. Characterize the product by 1H and 13C NMR spectroscopies and ESI-MS. (see the expected out-

comes section).

Figure 3. Solution injection tool

(A) A 5-mL disposable plastic syringe.

(B) A 16-G blunt-tip stainless needle; 80 mm in length.

(C–E) Silicone tubes (1.0 mm ID 3 2.0 mm OD). The lengths were 45 cm (C), 37 cm (D), and 17 cm (E).

(F) A polypropylene male Luer fitting.

(G) A polypropylene female Luer fitting.

(H and I) 16-G stainless tubes prepared from the 16-G blunt-tip stainless needle.
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Pause point: At this point, the product can be stored at 4�C for at least 3 months.

Synthesis of tert-butyl 4-(6-formyl-7-hydroxy-3,4-dihydroquinolin-1(2H)-yl)butanoate (3)

Timing: 30 h

This method outlines the preparation of compound 3 (Figure S1).

8. Using a syringe, add 2.0 mL of dry DMF in a 50 mL dried two-neck round-bottom flask under N2.

9. Add 181 mg (1.18 mmol) of POCl3 dropwise to the aforementioned flask at 0�C.
10. Stir the solution for 5 min at 0�C.
11. Stir for 15 min at room temperature (20–25�C).
12. After cooling down to 0�C, add dropwise 225 mg (0.772 mmol) of compound 2 in 2.0 mL of dry

DMF to the solution using a syringe.

13. Stir the reaction mixture at 0�C for 5 min.

14. After stirring at room temperature (20–25�C) for 24 h, pour the reactionmixture into 25mL of the

cold saturated aqueous solution of NaHCO3.

15. Extract the mixture using the 1:1 mixture of EtOAc/Et2O (5 3 50 mL) in a separatory funnel. Dry

the organic layers with Na2SO4. Condense the organic layers using a rotary evaporator to afford

compound 3 (240 mg, 0.751 mmol, yield 97%, Rf = 0.35 (EtOAc/Hexane = 1/4)) as pale yellow

oil.

16. Characterize the product by 1H and 13C NMR spectroscopies and ESI-MS. (see the expected

outcomes section).

Pause point: At this point, the product can be stored at 4�C for at least 3 months.

Synthesis of tert-butyl 4-(3-nitro-2-oxo-7,8-dihydro-2H-pyrano[3,2-g]quinolin-9(6H)-yl)

butanoate (4)

Timing: 12 h

This method outlines the preparation of compound 4 (Figure S1).

17. Weigh 1.91 g (5.98 mmol) of compound 3 and add it in a 300 mL dried two-neck round-bottom

flask under N2.

18. Using syringes, add 0.740 mL (6.67 mmol) of ethyl nitroacetate, 90 mL (0.91 mmol) of piperidine,

180 mL (3.15 mmol) of AcOH, and 60 mL of 1-butanol.

19. Stir the suspension for 5 h at 120�C.
20. After cooling to 0�C, collect the resulting precipitate by filtration.

21. Wash the precipitate with 20 mL of 1-butanol and 20 mL of hexane.

22. Dry the solid in vacuo at 50�C to obtain compound 4 (1.98 g, 5.10 mmol, yield 85%, Rf = 0.5

(EtOAc/Hexane = 1/1)) as a red solid.

23. Characterize the product by 1H and 13C NMR spectroscopies and ESI-MS. (see the expected

outcomes section).

Pause point: At this point, the product can be stored at 4�C for at least 3 months.

Synthesis of tert-butyl 4-(3-amino-2-oxo-7,8-dihydro-2H-pyrano[3,2-g]quinolin-9(6H)-yl)

butanoate (5)

Timing: 10 h

This method outlines the preparation of compound 5 (Figure S1).
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24. Weigh 301 mg (0.775 mmol) of compound 4 in a 50 mL round-bottom flask containing a mag-

netic stirring bar.

25. Add 20 mL of MeOH/CH2Cl2 (3:1, v/v) and 9.8 mg of Pd/C.

26. Place an H2 balloon with a three-way stopcock on the flask and replace the atmosphere with H2

using three vacuum–fill cycles.

27. Stir at room temperature (20–25�C) for 3 h under H2.

28. Filter the reaction mixture via celite, and wash the celite with MeOH and CH2Cl2.

29. Remove the volatile material using a rotary evaporator under reduced pressure to afford a crude

product.

30. Purify the crude product using silica gel column chromatography (EtOAc/hexane = 15/85) to afford

compound 5 (265 mg, 739 mmol, yield 95%, Rf = 0.5 (MeOH/CH2Cl2 = 5/95)) as pale yellow oil.

31. Characterize the product by 1H and 13C NMR spectroscopies and ESI-MS. (see the expected

outcomes section).

Pause point: At this point, the product can be stored at 4�C for at least 3 months.

Synthesis of tert-butyl 4-(3-(bis(pyridin-2-ylmethyl)amino)-2-oxo-7,8-dihydro-2H-pyrano[3,2-

g]quinolin-9(6H)-yl)butanoate (6)

Timing: 31 h

This method outlines the preparation of compound 6 (Figure S1).

32. Weigh 265 mg (0.739 mmol) of compound 5 and add it in a 200 mL dried two-neck round-bot-

tom flask under N2.

33. Add 40mL of dry MeCN using a syringe, 391mg (1.55mmol) of 2-(bromomethyl)pyridine hydro-

bromide, and 308 mg (2.23 mmol) of K2CO3.

34. Stir at 90�C for 25 h under N2.

35. After cooling to room temperature (20–25�C), extract the reaction mixture with CH2Cl2. Wash

the organic layer with water (2 3 50 mL), a 2% aqueous solution of Na2S2O3 (2 3 50 mL), and

brine (23 50 mL). Dry the organic layer with Na2SO4. After removing the solvents using a rotary

evaporator, purify the crude product using amino-functionalized silica gel column chromatog-

raphy (MeOH/CH2Cl2 = 5/95) to afford compound 6 (43.2 mg, 79.9 mmol, yield 11%, Rf = 0.6

(MeOH/CH2Cl2 = 5/95) on NH2-modified TLC) as a brown oil.

36. Characterize the product by 1H and 13C NMR spectroscopies and ESI-MS. (see the expected

outcomes section).

Pause point: At this point, the product can be stored at 4�C for at least 3 months.

Synthesis of 4-(3-(bis(pyridin-2-ylmethyl)amino)-2-oxo-7,8-dihydro-2H-pyrano[3,2-g]quinolin-

9(6H)-yl)butanoic acid (ZnDA-1)

Timing: 16 h

This method outlines the preparation of compound ZnDA-1 (Figure S1).

37. Weigh 101 mg (0.187 mmol) of compound 6 and add it in a 50 mL dried two-neck round-bottom

flask under N2.

38. Using syringes, add 4.0 mL of dry CH2Cl2 and 0.50 mL of TFA.

39. Stir the mixture at room temperature (20–25�C) for 13 h.

40. Remove volatile materials using a rotary evaporator to afford ZnDA-1 (92.0 mg) as a brown oil.

41. Use the crude product in the next step without further purification.
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Synthesis of 4-(3-(bis(pyridin-2-ylmethyl)amino)-2-oxo-7,8-dihydro-2H-pyrano[3,2-g]quinolin-

9(6H)-yl)-N-(2-(2-((6-chlorohexyl)oxy)ethoxy)ethyl)butanamide (ZnDA-1H)

Timing: 4 days

This step describes how to prepare the compound ZnDA-1H (Figure S1).

42. Add 92.0 mg of crude ZnDA-1 in a 100 mL dried two-neck flask under N2.

43. Add 4.0 mL of dry DMF using a syringe, 50.1 mg (0.261 mmol) of EDC$HCl, 60.8 mg

(0.272 mmol) of 2-(2-((6-chlorohexyl)oxy)ethoxy)ethan-1-amine (Singh et al., 2013), 45.0 mg

(0.294 mmol) of HOBt$H2O, and dry Et3N (75.0 mL, 0.565 mmol).

44. Stir at room temperature (20–25�C) for 78 h under N2.

45. After adding 20 mL of water, extract the mixture with CH2Cl2 and wash the organic layer with

saturated aqueous solution of NaHCO3 (2 3 20 mL), water (2 3 20 mL), 10% citric acid (2 3

20 mL), and brine (2 3 20 mL). Dry the organic layer with Na2SO4. After removal of the solvent

using a rotary evaporator, purify using amino-functionalized silica gel column chromatography

(EtOAc/hexane = 30/70) to afford 32.6 mg of ZnDA-1H as a mixture. Purify further using

reversed-phase HPLC (0.1% HCOOH in water/0.1% HCOOH in MeCN = 80/20 (v/v, 0 min),

20/80 (v/v, 15 min), 0/100 (v/v, 20 min), and 0/100 (v/v, 30 min)). Lyophilize the fractions to afford

ZnDA-1H (25.8 mg, 0.0374 mmol, 20% over 2 steps, Rf = 0.3 (MeOH/CH2Cl2 = 10/90) on NH2-

modified TLC) as a yellow oil.

46. Characterize the product by 1H and 13C NMR spectroscopies and ESI-MS. (see the expected

outcomes section).

Pause point: At this point, the product can be stored at 4�C for at least 3 months.

Note: Step 44: Monitor the reaction progress using TLC as the condensation reaction of the

carboxylic acid and the amine is typically completed in approximately one day.

Seeding cells in imaging dishes

Timing: 0.5–1 h

This method outlines the preparation of HeLa cells in an imaging dish.

47. Detach HeLa cells from a 60-mm culture dish:

a. Aspirate the medium.

b. Wash twice with 2 mL of Ca2+/Mg2+-free PBS.

c. Aspirate PBS.

d. Add 500 mL of PBS and 500 mL of trypsin/EDTA solution and tilt the dish to spread the solution

on the dish surface.

e. Incubate the cells at 37�C for 2 min.

f. Add 500 mL of antibiotics-free MEM containing 10% FBS.

g. Suspend the cells using gentle pipetting.

48. Count the cell number:

a. Take 10 mL of the cell suspension and mix with 10 mL of trypan blue stain.

b. Add the suspension to a hemocytometer.

c. Count the cell number under a microscope.

49. Seed the cells in a 35-mm glass-bottom dish:

a. Add 2 mL of antibiotics-free MEM containing 10% FBS.

b. Add 2.5 3 104 cells to the dish.

c. Gently shake the dish with an upwards and downwards motion and from left to right.

50. Incubate the cells for 24 h at 37�C in a humidified incubator containing 5% CO2.
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Note: Step 49: Adjust the number of cells to be seeded according to the cell proliferation rate

so that the cell density is not too high (30–50%) on the imaging day.

Transfection of cells with a HaloTag expression vector

Timing: 30 min

This method describes the transfection of cells with a plasmid encoding a fusion protein of human

mannosidase II and HaloTag using FuGENE HD as a transfection reagent. HaloTag is a mutant bac-

terial haloalkane dehalogenase that can specifically form a covalent bond with its substrate, such as a

functional small molecule conjugated with a 6-chlorohexyl group. This protein is widely used to label

intracellular proteins with functional molecules.

51. Prepare a solution of FuGENE HD transfection reagent and a plasmid DNA mixture with the

following steps:

a. Add 100 mL of Opti-MEM to a sterile 1.5 mL tube.

b. Add 150 ng of the plasmid DNA (pEF4MycHisB-hManII-Halo) and mix by pipetting.

c. Add 1.05 mL of FuGENE HD (a 7:1 ratio of FuGENE HD and DNA) and mix immediately by

pipetting (troubleshooting 1) (troubleshooting 2).

d. Incubate for 15 min at room temperature (20–25�C).
52. Add the mixture to the imaging dish and gently shake the dish with an upwards and downwards

motion and from left to right.

53. Incubate the cells for 36 h at 37�C in a humidified incubator containing 5% CO2.

CRITICAL: The use of antibiotics during the transfection should be avoided because it may

affect the transfection efficiency and worsen the cellular health.

CRITICAL: The total amount of plasmid DNA, the ratio of FuGENE HD and the DNA, and

the incubation time after the addition of the transfection reagent/DNA mixture should be

optimized to obtain proper expression and intracellular distribution of the HaloTag fusion

protein prior to the assay. We observed a high rate of cell death and an increased popu-

lation of cells in which the HaloTag was mislocalized upon using a higher amount of the

plasmid DNA (250 ng).

Note: Other transfection reagents can be used instead of FuGENE HD. In that case, the opti-

mization of the transfection conditions may be required.

Time-lapse imaging of transfected cells

Timing: 2–2.5 h

This method describes the labeling of the HaloTag expressed in the transfected cells with ZnDA-1H

and HTL-TMR and time-lapse imaging for the quantification of labile Zn2+ concentration using the in

situ standard quantification method (Figure 1).

54. Set up the microscope:

a. Turn on the temperature controller of the on-stage incubation chamber and the light source.

b. Choose a proper objective lens.

c. Assemble the hand-made solution injection tool (Figure 4).

d. Clean and moisten the interior of the injection tube using 70% EtOH and water (2 3 200 mL).

55. Aspirate the medium from the imaging dish.

56. Wash twice with 1 mL of HBSS (+).

57. Label the HaloTag expressed in the cells with the probes as per the following procedure:
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a. Add 990 mL of DMEM containing 4 mM glutamine.

b. Add 10 mL of DMEM containing 4 mM glutamine, 25 mM ZnDA-1H, and 0.50 mM HTL-TMR.

c. After gentle shaking, incubate the dish for 30 min at 37�C in a humidified incubator contain-

ing 5% CO2.

58. Wash twice with 1 mL of HBSS (+).

59. Add 1.9 mL of chelexed HHBSS buffer supplemented with Ca2+ and Zn2+.

60. Supplement 180 mL of chelexed HHBSS buffer with 18.2 mL of 20 mM ZnSO4. Heat the solution

along with 200 mM TPEN solution at 37�C.
61. Add a drop of proper oil to the objective lens, if necessary, and place the dish on a pre-warmed

on-stage incubation chamber of an inverted laser scanning confocal microscope (trouble-

shooting 3).

62. Replace the normal dish lid with a lid with a small hole (Figure 2) and insert the end of the injec-

tion tube into the hole (troubleshooting 4).

63. Set the imaging parameters of FluoView software (Figure 5): Excitation laser: 473 nm (ZnDA-1H),

559 nm (HTL-TMR); Emission filters: 490–540 nm (ZnDA-1H), 575–675 nm (HTL-TMR). See the

caption of Figure 5 for more details.

64. Find and focus cells that show fluorescence signals of both probes and proper protein localiza-

tion.

65. Mix 2.2 mL of 2.0 mM pyrithione in DMSO with chelexed HHBSS buffer supplemented with Zn2.

66. Start image acquisition.

67. Add 100 mL of 200 mM TPEN solution (f. c. 10 mM) after 2 min to obtain the minimum intensity

values of ZnDA-1H.

68. Add 200 mL of the ZPT solution (f. c. 400 mM Zn2+/2.0 mM pyrithione) after 7 min to obtain the

maximum intensity values of ZnDA-1H.

69. After acquiring the images, wash the injection tube interior with 70% EtOH and water (2 3

200 mL).

70. Wipe off the oil from the objective lens.

Figure 4. Assembly of the solution injection tool and an on-stage incubator

(A) Insert the stainless tube into an inlet port.

(B) Place the tip of the injection tool close to the top of the glass part of the dish.
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CRITICAL: Before starting image acquisition, the imaging dish should be incubated for

15 min in the on-stage incubation chamber to obtain stable fluorescence signals.

CRITICAL: The end of the injection tube should be positioned over the glass part of the

dish, not touching the imaging medium. Otherwise, diffusion of the added solution may

not be efficient and quick responses might not be obtained upon the addition of ZPT

and TPEN solutions.

CRITICAL: Do not use higher laser power to avoid photobleaching of the probes. In our

study, we used 0.2% laser power (Head output: 473 nm: 15 mW; 559 nm: 15 mW).

CRITICAL: Adjust the values of HV and gain so that the ZnDA-1H fluorescence signals are

not saturated upon the addition of ZPT.

CRITICAL: Avoid adding TPEN and ZPT solutions during scanning.

Figure 5. Acquisition setting in the software FluoView

(A) Light path: Select the high-sensitivity GaAsP detector. Dichroic mirror: 560 nm. Band-pass filters: 490–540 nm (for

ZnDA-1H); 575–675 nm (for HTL-TMR).

(B) Scan speed: 2.0 ms/pixel. Frame size: 1024 3 1024 pixels. Zoom: 1.0. Laser power: 0.2% (473 nm); 0.2% (559 nm).

Objective lens: 603, silicone oil-immersion (UPLSAPO60XS2, NA 1.30). Autofocus: Put check ‘‘Enable ZDC AF during

Time Series Scan’’ in order to use z-drift compensator. Time interval: 30 s. Scan number: 27.

(C) HV: Set a proper value between 500 and 700 to obtain sufficient fluorescence signals. Gain: 1. Offset: 0. Confocal

aperture: 120 (auto).
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Note: In our study, we used only the 603 silicone oil immersion objective lens (UPLSA-

PO60XS2, NA 1.30) for quantifying Zn2+ concentration. Although our method is theoretically

independent of the type of objective lens, it is desirable to use an objective lens with a larger

NA to obtain sufficiently high signals with a lower laser power considering that the photo-

bleaching of the probes impairs quantitativeness.

Note: In principle, this quantification method can be applied not only to confocal microscopy

but also to other fluorescence microscopic techniques as long as the quantitativeness of the

detected fluorescence signals is maintained.

Note: Step 64: When searching the cells for imaging, use a larger CA value (for example 300)

rather than a higher laser power to detect lower ZnDA-1H fluorescence signals at the steady-

state and to avoid photobleaching.

Note: Steps 67 and 68: Disconnect the Luer fittings, add the solution into the tube using a micro-

pipette, and retain the solution in themiddle of the tube. Reconnect the Luer fittings, andwhen the

time for addition comes, drip the solution slowly into the dish by pushing air through the syringe.

Image processing and analysis

Timing: 1–2 h

This method describes how to process the time-lapse imaging data using the Fiji software to quantify

labile Zn2+ concentration (Figure 6).

71. Open time-lapse images using the FIJI software.

72. Reduce the noise by applying a median filter to both ZnDA-1H and HTL-TMR channels:

a. Process -> Filters -> Median -> Enter ‘‘1.0’’ pixels -> Press ‘‘OK’’

b. Press ‘‘Yes’’ when you are asked if you want to ‘‘Process all images’’.

73. Subtract the background:

Figure 6. Schematic illustration of imaging data-processing

A median filter algorithm (1 px) was applied to raw images in order to remove sharp spike noises. For background

subtraction, the mean intensity of the cell-free region was subtracted from each image. To remove the background

and obtain the fluorescence intensity only from the target organelle, a mask image was created from an image in the

TMR channel using the Otsu threshold algorithm and applied to images in both the TMR and ZnDA channels. Regions

of interest (ROIs) were circled to select the target organelle within the single cell. The line profiles indicate the

fluorescence intensities of HTL-TMR, which were measured along the green and magenta lines in the images.
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a. Select the region where the cells are not present as a background using a rectangle tool and

add to the ROI manager: Analyze -> Tools -> ROI Manager -> Add (shortcut: [t]).

b. Measure the mean value in the ROI: Analyze -> Measure (shortcut: [m]).

c. Subtract the mean value from the image: Process -> Math -> Subtract -> Enter the mean

value -> Press ‘‘OK’’

d. Repeat this process for all slices, or use the plug-in ‘‘Subtract_Measured_Background.ijm’’ depos-

ited on GitHub (https://github.com/JoachimGoedhart/Quantify-Intensity-from-Timelapse).

74. Create a binary mask:

a. Duplicate the HTL-TMR channel stack: Image -> Duplicate (shortcut: ctrl + shift + [d])

b. Threshold the ROIs of the duplicated HTL-TMR channel stack: Image -> Adjust -> Threshold

(shortcut: ctrl + shift + [t]).

c. Choose a proper algorithm to extract the desired ROIs (troubleshooting 5).

d. Convert the thresholdedROIs intobinary: Process ->Math ->Divide ->Enter ‘‘255’’ ->Press ‘‘OK’’.

e. Press ‘‘Yes’’ when you are asked if you want to ‘‘Process all images’’.

f. Save the binary stack as ‘‘mask.tiff’’.

75. Apply the mask to both ZnDA-1H and HTL-TMR channel stacks.

a. Process -> Image Calculator

b. Select the file for the ZnDA-1H channel stack as Image 1 and the mask file as Image 2, select

‘‘Multiply’’ in the operation tab, and put checks to ‘‘Create new window’’ and ‘‘32-bit (float)

result’’. Press ‘‘OK’’.

c. Press ‘‘Yes’’ when you are asked if you want to ‘‘Process all images’’.

d. Repeat for the HTL-TMR channel stack.

76. Draw a circle to select the ROI for each cell in the HTL-TMR channel stack and add it to the ROI

manager (shortcut: [t]).

77. Set measurements to obtain the total fluorescence intensity in the ROIs:

a. Analyze -> Set Measurements -> Put a check to ‘‘Integrated density’’.

Figure 7. Quantitative imaging of [Zn2+] in the Golgi apparatus in live HeLa cells via the combination of ZnDA-1H

and HTL-TMR

(A) Confocal microscopy images of ZnDA-1H and HTL-TMR targeted into the Golgi apparatus. HaloTag proteins

expressed in the Golgi were labeled with both 0.25 mM ZnDA-1H and 5.0 nM HTL-TMR. Scale bar: 20 mm. For

intracellular Zn2+ calibration in live cells, 10 mM TPEN was added after 2 min, and Zn2+/pyrithione (ZPT, 400 mM Zn2+/2

mM pyrithione) was added after 7 min. Cell boundaries were manually traced with a yellow dotted line.

(B) Time course of the fluorescence ratios (black) and intensities of ZnDA-1H (green) and HTL-TMR (orange). Error bars

represent SEM (n = 106,N = 9). n andN indicate the numbers of the examined cells and the independent experiments,

respectively.

(C) [Zn2+]Golgi at the steady-state in HeLa cells. A plot was constructed from the dataset as shown in Figure 7B. A red

dot represents the mean value.

Modified and reproduced with permission from Kowada et al., 2020.
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78. Obtain the total fluorescence intensity of both ZnDA-1H and HTL-TMR from each ROI:

a. Select ROIs in the ROI manager, and then, More ->Multi Measure. Put checks to ‘‘Measure all

slices’’ and ‘‘One row per slice’’. Press ‘‘OK’’.

b. Save the results as CSV files. In the ‘‘Results’’ window, File -> Save As.

c. Perform for both ZnDA-1H and HTL-TMR channel stacks.

79. Open the CSV files, calculate the ratio of ZnDA-1H/HTL-TMR, and plot the data (Figure 7). We

used Microsoft Excel and KaleidaGraph.

80. Calculate labile Zn2+ concentration in the Golgi apparatus ([Zn2+]Golgi) using the following equa-

tion:

[Zn2+]Golgi = Kd 3 (Rss – Rmin)/(Rmax – Rss),

where Kd is the apparent dissociation constant of Halo-ZnDA-1H toward Zn2+ at pH 6.5 (Kd = 0.54G

0.05 mM), and R is the fluorescence signal ratio of ZnDA-1H andHTL-TMR. The subscript ss denotes a

steady-state.

Note: Step 73: Alternatively, you can perform background subtraction differently. Process ->

Subtract background -> Enter a sufficiently large value into ‘‘Rolling ball radius’’.

Table 1. NMR and MS data

Compound 1H NMR, d [ppm] 13C NMR, d [ppm] HRMS (ESI)

2 400 MHz, CDCl3
6.76 (d, J = 7.9 Hz, 1H), 6.13 (d, J =
2.4 Hz, 1H), 6.05 (dd, J = 7.9, 2.4 Hz,
1H), 5.25 (br s, 1H), 3.25–3.19 (m, 4H),
2.66 (t, J = 6.3 Hz, 2H), 2.27 (t, J =
7.2 Hz, 2H), 1.92–1.84 (m, 4H), 1.46 (s,
9H)

100 MHz, CDCl3
173.0, 155.2, 146.1, 129.7, 114.7,
102.3, 97.8, 80.6, 50.8, 49.4, 32.9,
28.1, 27.4, 22.4, 21.7

Calcd for C17H25NNaO3
+ [M + Na]+,

314.1727; found 314.1718

3 400 MHz, CDCl3
11.58 (s, 1H), 9.42 (s, 1H), 6.95 (s, 1H),
6.02 (s, 1H), 3.38–3.31
(m, 4H), 2.67 (t, J = 6.1 Hz, 2H), 2.28 (t,
J = 7.2 Hz, 2H), 1.95–1.87 (m, 4H), 1.46
(s, 9H).

100 MHz, CDCl3
191.6, 172.1, 163.4, 152.1, 133.2,
114.7, 111.1, 95.7, 80.7, 50.8, 49.7,
32.6, 28.1, 27.1, 21.7, 21.6

Calcd for C18H26NO4
+ [M + H]+,

320.1856; found 320.1871

4 400 MHz, CDCl3
8.60 (s, 1H), 7.10 (s, 1H), 6.44 (s, 1H),
3.50 (t, J = 5.7 Hz, 2H), 3.43 (t, J =
7.8 Hz, 2H), 2.79 (t, J= 6.1 Hz, 2H), 2.32
(t, J = 7.0 Hz, 2H), 2.00–1.91 (m, 4H),
1.47 (s, 9H)

100 MHz, CDCl3
171.8, 157.0, 153.5, 152.9, 142.8,
129.9, 126.2, 122.4, 106.3, 95.7, 81.0,
51.3, 50.0, 32.2, 28.1, 27.2, 21.3, 20.9

Calcd for C20H24N2O6
+ [M + H]+,

389.1707; found 389.1725

5 400 MHz, CDCl3
6.83 (s, 1H), 6.64 (s, 1H), 6.44 (s, 1H),
3.30 (dt, J = 10.4, 5.6 Hz, 4H), 2.74 (t,
J = 6.0 Hz, 2H), 2.28 (t, J = 7.3 Hz, 2H),
1.97–1.87 (m, 4H), 1.46 (s, 9H)

100 MHz, CDCl3
172.4, 160.3, 150.2, 144.9, 127.5,
124.8, 120.0, 114.4, 109.6, 96.8, 80.5,
50.8, 49.3, 32.7, 28.1, 27.7, 21.9, 21.4

Calcd for C20H26N2NaO4
+ [M + Na]+,

381.1785; found 381.1790

6 400 MHz, CDCl3
8.50 (ddd, J = 4.9, 1.5, 0.9 Hz, 2H),
7.62–6.72 (m, 4H), 7.11 (ddd, J = 6.7,
4.9, 1.4 Hz, 2H), 6.75 (d, J= 7.1 Hz, 2H),
6.40 (s, 1H), 4.56 (s, 4H), 3.31–3.24 (m,
4H), 2.67 (t, J = 6.2, 2H), 2.26 (t, J =
7.3 Hz, 2H), 1.92–1.83 (m, 4H), 1.46 (s,
9H)

100 MHz, CDCl3
172.3, 160.3, 158.6, 151.4, 148.9,
145.8, 136.6, 130.1, 126.0, 125.1,
122.7, 122.1, 119.7, 108.9, 96.2, 80.6,
57.5, 50.8, 49.3, 32.7. 28.1, 27.6, 21.8,
21.4

Calcd for C32H36N4NaO4
+ [M + Na]+,

563.2629; found 563.2642

ZnDA-1H 500 MHz, CDCl3
8.52 (d, J = 4.70 Hz, 2H), 7.64–7.56 (m,
4H), 7.14 (dd, J = 5.8, 5.8 Hz, 2H), 6.78
(s, 1H), 6.76 (s, 1H), 6.40 (s, 1H), 6.08 (t,
J = 4.8 Hz, 1H), 4.57 (s, 4H), 3.63–3.46
(m, 13H), 3.33–3.29 (m, 4H), 2.69 (t, J =
6.2 Hz, 2H), 2.23 (t, J = 7.3 Hz, 2H),
2.25–1.27 (m, 15H)

125 MHz, CDCl3
171.9, 160.3, 158.5, 151.4, 148.9 (2C),
145.9, 136.6 (2C), 130.0, 126.0, 125.1,
122.7 (2C), 122.1 (2C), 119.7, 108.8,
96.1, 71.2, 70.2, 70.0, 69.8, 57.4, 50.8,
49.2, 45.0, 39.2, 33.4, 32.5, 29.4, 27.6,
26.6, 25.4, 21.805, 21.795

Calcd for C38H49
35ClN5O5

+ [M + H]+,
690.3417; found 690.3407

ll
OPEN ACCESS

16 STAR Protocols Volume, 100395, June 18, 2021

Protocol



Note: Step 74c: In our study, we used the ‘‘Otsu’’ threshold algorithm. Alternatively, you can

use Huang or other algorithms to determine a proper threshold.

Note: Step 80: We used the Kd value determined at pH 6.5 for the estimation of [Zn2+]Golgi as

the pH in the Golgi can vary from 6.7 to 6.0. You can also estimate [Zn2+]Golgi at a different pH

by applying different Kd values determined under different pH conditions.

EXPECTED OUTCOMES

ZnDA-1H is synthesized according to the 7-step reactions shown in Figure S1. The characterization

data are summarized in Table 1. NMR spectra are shown in Figures 8, 9, 10, 11, 12, and 13.

At a steady-state, weak fluorescence signals of ZnDA-1H can be detected from the Golgi apparatus

accompanied by HTL-TMR fluorescence signals (Figure 7A). For the [Zn2+]Golgi quantification, intra-

cellular calibration is necessary, and TPEN and ZPT are used for the depletion and saturation of labile

Zn2+, respectively (Figures 7A and 7B). After processing the imaging data (Figure 6), the resulting

ratio values are used for calculating [Zn2+]Golgi (Figure 7C).

Figure 8. 1H (400 MHz, upper) and 13C NMR (100 MHz, lower) spectra of 2 in CDCl3
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QUANTIFICATION AND STATISTICAL ANALYSIS

The average, standard deviation (SD), and standard error of the mean (SEM) values were calculated

using Microsoft Excel. Microscopic images were processed using ImageJ (Fiji).

LIMITATIONS

The Kd value of ZnDA-1H toward Zn2+ ranges from 0.30 mM to 0.54 mM at pH 7.4–6.5. In our

quantification protocol, the Kd value at pH 6.5 (generally considered as the pH value of the

Golgi apparatus) is used to estimate the concentration of Zn2+ in the Golgi apparatus. However,

intracellular pH fluctuations during imaging can affect the results of Zn2+ quantification. It is

preferable to simultaneously monitor both Zn2+ concentration and pH level with a Zn2+ probe

and a pH probe.

To quantify the concentration of labile Zn2+ with high accuracy, zinc levels in organelles should be

in the range of 0.1–10 times the Kd value of the Zn2+ probe. Our data (Kowada et al.) indicated

that labile Zn2+ concentrations in the mitochondria, cytosol, nucleus, and ER of HeLa cells were

lower than the detection limit of ZnDA-1H. The results are consistent with those of studies report-

ing that steady-state Zn2+ concentrations in such subcellular compartments range from the pM to

Figure 9. 1H (400 MHz, upper) and 13C NMR (100 MHz, lower) spectra of 3 in CDCl3
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sub-nM levels (Kambe et al., 2015). In our latest unpublished study, we developed several ZnDA-

1H derivatives with higher affinity for Zn2+ with a Kd value for Zn2+ ranging from tens of pM to nM

and confirmed that our method is applicable to the quantification of Zn2+ concentrations in the

above-mentioned subcellular compartments using these Zn2+ probes.

HaloTag expression in cells is required to localize ZnDA-1H to target subcellular regions. Therefore,

this quantification method is not applicable to samples where it is difficult to genetically express

HaloTag.

TROUBLESHOOTING

Problem 1

Mislocalization of the HaloTag-fused protein

Potential solution

Overexpression of the HaloTag-fused protein in the Golgi apparatus may lead to the mislocalization

of the expressed protein. We observed the strong fluorescence signals of mislocalized proteins

mainly frommembrane fractions such as the plasmamembrane and perinuclear regions. If the probe

Figure 10. 1H (400 MHz, upper) and 13C NMR (100 MHz, lower) spectra of 4 in CDCl3
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fluorescence is observed from a location other than the Golgi apparatus, optimize transfection con-

ditions by changing the amount of the plasmid DNA, the ratio of the DNA and a transfection reagent,

and incubation time after transfection. We have used only HeLa cells and HEK293T cells and found

that it was more difficult to reduce the expression level of HaloTag to prevent its mislocalization in

HEK293T cells. To confirm HaloTag expression in the Golgi apparatus, we performed immunostain-

ing using anti-GM130 rabbit polyclonal antibody (1:1000) and CF568-conjugated donkey-anti-rab-

bit IgG (1:1000). Establishing stable cell lines may be an effective solution to ensure HaloTag expres-

sion in the target regions.

Problem 2

Increased cell death by transfection

Potential solution

Since the overexpression of transfected genes is one of the causes of increased cell death, the

transfection conditions should be optimized. In HeLa cells expressing mannosidase II-fused Halo-

Tag, there were more dead cells following treatment with 250 ng of plasmid DNA compared with

150 ng of the plasmid. Exchanging medium to remove the transfection reagent 3–5 h after

Figure 11. 1H (400 MHz, upper) and 13C NMR (100 MHz, lower) spectra of 5 in CDCl3
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transfection may be effective, although it is not required according to the standard protocol of

FuGENE HD.

Problem 3

Appearance of bubbles in the field of view during time-lapse imaging

Potential solution

Remove the oil cleanly from the objective lens with a lens cleaner, and apply oil on it again. If you

leave the oil container upside down for a while before applying the oil, it will prevent the inclusion

of air bubbles. It is also effective to discard the first drop of oil before adding oil to an objective lens.

Problem 4

No change in the fluorescence signal or time lag after the addition of TPEN or ZPT

Potential solution

Since the reagent solution may have been dropped far from the observation area, place the tip of the

injection tube near the glass-plastic interface of the glass bottom dish.

Figure 12. 1H (400 MHz, upper) and 13C NMR (100 MHz, lower) spectra of 6 in CDCl3
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Problem 5

The error ‘‘Threshold is not set’’ appears.

Potential solution

Set a threshold after converting the image depth to 8 bit.

RESOURCE AVAILABILITY

Lead contact

Shin Mizukami (shin.mizukami@tohoku.ac.jp).

Materials availability

Requests for resources and reagents should be directed to and will be fulfilled by the lead contact.

Data and code availability

This study did not generate any datasets or code.

Figure 13. 1H (500 MHz, upper) and 13C NMR (125 MHz, lower) spectra of ZnDA-1H in CDCl3
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